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About This User Guide 
There are screen shots throughout this guide. Due to customer-specific modifications to field names, 

field tabs, and locations these screen shots may not match those used within your instance. 

TIPS 

 Where displayed, this section offers a best practice. 

  

Content Home 

Set User Default Options  

Modify Columns 

Each user can customize the visible columns, which can be used for filtering and sorting results. 

1. From the main menu, click Content. 

 

2. Click the Modify Columns icon. 
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Add Columns  

1. From the Columns list, select an attribute to add. 

2. Click the plus icon to move the attribute to the Visible Columns. 

3. Confirm the new value is in the Visible Columns and click OK to save your changes. 

 

Remove Columns  

1. From the Visible Columns list, select an attribute to remove. 
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2. Click the minus icon and click OK to save your changes. 

 

Order Columns 

1. Select the attribute to move and use the up and down arrows to move attributes to the desired 

order, and then click OK. 
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Default Options 

1. To enable the hover preview, check the "Show search preview on hover" box. 
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2. Choose how many rows of text to show in search results grid. 
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3. Choose the maximum number of rows to display in search results grid. 
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Content Home Options  

To search for content, follow the steps below, referencing the circled numbers. 

 

If you are not on the Content page, go to the main menu and click Content. 

 

1. Type the words to search within Search Here window: 

 To perform an exact match search, put quotation marks around the text that should be an 

exact match 

 To perform a single word search and remove the automatic alternate word search put 

quotation marks around the word that should be an exact match 

 To search for a record by number, enter "id:" followed by the Search ID number. 

2. Click the Search Files button. 

3. Search Words display the words and language searched. 

4. Click Show Options to expand the window that shows all search options. 

5. Click Clear Search to remove all search text. 

6. Click Save Search to add the saved result options as a new favorite search. 

7. Click Open Search to use a previously saved favorite search. 

8. Click Show Preview to expand the preview window. 
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Search Options  

To modify your search options, follow the steps below, referencing the circled numbers. Click Show 

Options to expand the options window. 

 

1. Choose your preferred option for what content to search: 

 All Content searches all text that is in all content record documents (includes Indexed content) 

 Q & A Only searches all text but only in records where the “Q & A” attribute is checked 

(excludes Indexed content) 

 Question Only searches only the question text but only in records where the “Q & A” attribute 

is checked (excludes Indexed content) 

 Short Description searches only the text within the Summary attribute field (note that your 

label may be different) 

2. Choose your preferred default option for what words to include in the search: 

 All Words returns records that include all words in search field 

 Any Word returns records that include any of the words in the search field 
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3. Choose your preferred option to search for records based on compliance status (this is based on 

the expiration date field): 

 All returns all records 

 Compliant returns records that have not yet expired 

 Non-Compliant returns records that have expired or where the expiration date is empty 

4. Choose whether to include customer configured synonyms in the search. 

5. Choose your preferred option to search for content expiring in the future (this is based on the 

expiration date field): 

 Next Week returns records expiring within the next 7 days 

 Next Month returns records expiring within the next 30 days 

 Next Quarter returns records expiring within in the next 90 days 

 Next Year returns records expiring within in the next 365 days 

6. To save your default options, click the Save Options. Important Note: This will include text in 

the search text field, filters, sorting, and all options in the Show Options window. Click Clear 

Search before clicking Save Options. 

7. Click Hide Options to collapse the search options. 

 

8. Click Show Preview to show the preview text window. 
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Sort Options 

To modify sort options, follow the steps below, referencing the circled numbers: 

 

1. Click on the attribute name for the column to sort, which will sort ascending. Click the same 

attribute name again to sort descending. 

2. To remove sorting, click Reset Sort. 

9. Click Reset Sort to remove all sorting. This button only shows when the sort is on for a column. 

Filters 

To filter your results, follow the steps below, referencing the circled numbers: 
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1. Click Modify Filters, and under Add new filter, select the attribute to use as a filter. Then, click 

Apply. 

2. To filter on a visible column's values, click the funnel icon next to that column name. Make 

selections and then click Apply. 
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3. To apply a quick filter, look for the value to filter on and right-click on that value. 

 

 

When filters are in place, the Current Filters section displays within the results grid. 
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Search Results Grid  

In the results grid, RocketDocs automatically displays important information on screen. 

 

1. The selected record has a light blue background. 

2. The selected record displays the record's Search ID. 

3. The record status displays in the first column: 

  indicates the expiration date is in the future 

  indicates the expiration date has passed or is empty 

  indicates review frequency is “Per Bid" 
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Additional Tabs  

The tabs to the right of Results provide details about a record. Label names may vary. 
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1. Attributes displays all attributes for the selected record. 
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2. Short Answer displays the text-only version of the selected record. 

 

3. Notes displays text-only notes related to the selected record. 
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4. History displays the usage history of the selected record. 
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5. Revisions displays the revision history of the selected record. This includes all prior saved versions 

of the record document. 
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6. Related displays the following details for the selected record: 

 General, parent, or child records 

 Sales docs or reponse forms in which the record is included 

 Assemblies in which the record is included 

 Proposals in which the record is inserted 

 Internal document info 
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7. Preview displays the full text-only content of the selected record, and includes the ability to: 

 Download the record document in its native format 

 Download the record document as a PDF 

 Download the record document as an image 

 

Filter and Sort Results 

Apply filters to search results using any column that displays the funnel button. 

Filter Results  

Auto Filter  

To quickly filter results on a single value, follow the steps below: 

1. Choose a column to filter. 

2. View a value in that column and right-mouse click on it.  
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Manual Filter  

To apply one or more filters, click the Modify Filters button, or click on the funnel  next to the 

column heading you'd like to use to filter. 

 

1. Choose a column to filter. 

2. Click on the funnel in that column header. 
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3. Select one or more values by checking the appropriate boxes then click Apply. 

 

TIPS 

 To add another field filter, select another field from the Add new filter dropdown. 

Multiple Fields 

1. Click on the Modify Filters button. 
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2. Select the field to use as a filter from the Add new filter dropdown. 

 

3. Check the boxes next to the values for the filter. 
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5. Make additional selections if desired, and then click Apply. 

 

Clear Filters 

A blue funnel  button indicates a filter is in place on that column.  

Remove a Single Filter  

1. Click on the filter button  and click Remove This Filter. 
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Remove All Filters  

1. To remove all filters, click the Clear Filters button. 

 

Sort Results  

1. To sort results in ascending order, click on the column header label once. 

 

2. To sort descending, click on the column header label a second time. 
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Reset Sort  

1. To remove all sort orders, click the Reset Sort button. 

  

Search Options  

Save Search 

Save Search allows you to create a favorite that can be repeated in the future. When you create a new 

saved search, it includes any text in the search text box, search options, filters, and sort order. To 

create a saved search, follow the steps below: 

1. Click the Save Search link. 
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2. Enter a name for your favorite, and then click Ok. Optional: share the saved search by checking 

Make available to all users. 

 

Open Search 

Open Search provides quick access to your saved searches and those others made available to all 

users. To open a saved search, follow the steps below: 

1. Click the Open Search link. 

 

Saved searches that you created will show under User. 
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Shared searches created by others will show under Global. 

 

2. Select a saved search from the dropdown and click Ok. 

 

Delete a Saved Search  

Users can only delete saved searches they created under their user account. To delete a saved search, 

follow the steps below: 

1. Click the Open Search link. 
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2. Select the saved search to delete from the dropdown and click Delete Selected. 

 

3. Click OK to proceed. 

 

4. To close the Save Search window, click Cancel or click the close button. 

 

Search  

There are several ways to search for text: 

 From the viewer toolbar by entering text in the box, and then click the magnifying glass 
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 From the Proposal Editor window by selecting text to search, and then click Search WebPro (3). 

 

 From Content > Home enter or paste text in the search text box, and then click Search Files 

 

 From Content > Home leave the search text box empty and apply options (1), filters (2), and 

sorting (3) 
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Insert Content 

There are several ways to insert records: 

 Insert Full 

 Insert Selected 

 Insert Short Answer 

Application Selector 

The PMAPS Application Selector facilitates usage of content by allowing the user to choose formatting 

options, as well as insert into any saved Microsoft Office document that is open. 

1. Under Insert Into Selected Application, select a formatting option. These options use Microsoft 
Word paste commands. Following are definitions of each option, as defined by Microsoft®. We 

recommend Use Destination Styles when using custom style names or when the Microsoft default 

styles have been modified to the user's company branding guidelines. 

 

 Keep Source Formatting—This option retains the look of the copied text by assigning the 

Normal style to the text and applying direct formatting. Direct formatting includes 

characteristics such as font size, italics, or other formatting to mimic the style definition of the 

copied text. 

 Use Destination Styles—This option retains the style name that is associated with the copied 

text, but it uses the style definition of the document where the text is being inserted. For 

example, you copy Heading 1 text from one document to another. In one document, Heading 

1 is defined as Arial bold, 14-point, and in the document where you are pasting the text, 

Heading 1 is defined as Cambria bold, 16-point. When you use the Use Destination Styles 

option, the pasted text uses Heading 1 style, Cambria bold, 16-point. 
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 Match Destination Formatting—This option discards the style definition and most formatting 

that was applied directly to the copied text, but it retains formatting that is considered 

emphasis, such as bold and italic, when it is applied to only a portion of the selection. The text 

takes on the style definition in the document where it is being pasted. 

 Define Formatting—Brings up a window that allows the user to define the font, size, color, and 

other formatting options including indentation. If you choose this option you will have to make 

selections on every insert. 

 Kept Text Only—This option discards all formatting and non-text elements such as pictures or 

tables. The text takes on the style characteristics of the paragraph where it is inserted and 

takes on any direct formatting or character style properties of text that immediately precedes 

the cursor when the text is pasted. Graphical elements are discarded, and tables are 

converted to a series of paragraphs. 

2. If desired, check the box to remember the selected application. This option saves a huge amount 

of time when working on the same document for multiple answers. 

 



 

 

User Guide: Content 33 Rev:  4/23/2019 

3. Choose the Active Application as the destination for the insert. This can be any saved Microsoft 
Office document that is open on the computer. To refresh the application selector because you 

have opened other documents, close the viewer and repeat the insert. 

 

4. Ensure that the cursor is where the content should be inserted. 

5. Click the Insert icon. 
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Insert Full  

1. Select the answer, click the Insert dropdown and choose Insert Full. 

 

Insert Selected Text  

1. Select the answer to use. 

2. Click Show Preview to expand the preview window (if not open) 

 

3. Select the text to insert, click the Insert dropdown and choose Insert Selected. 
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Insert Short Answer  

This option is only available if the Short Answer tab is populated for the content record selected. 

1. Select the record that contains the Short Answer to use, and then click Insert Short Answer. 

 

TIPS 

 Use the Copy to Clipboard option from the Application Selector to copy the short answer to 

your clipboard and paste it into a web form. 

Found  

The Found option allows the user to add record usage without using any of the insert options. 

1. Select the record that contains the content used, click the Insert menu and then click Found. 

 

Insert from Document  

1. View the record that contains the content to use. 

 



 

 

User Guide: Content 36 Rev:  4/23/2019 

2. Click the icon for the insert type (Insert Full, Insert Selected, Insert Short Answer, Found). 

 

 To insert the entire answer, click the Insert Full button. 

 

 To insert a selected portion of the answer, click the Insert Selected Text button. 

 

 To insert the short answer, click the Insert Short Answer button. 

 

 To "use" the record, click the Mark Document as 'Found' button. 
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Insert Word Replacements  

The Run Word Replacements feature works in any document that open from the Proposals home page 

when using Insert Full or Insert Selected Text. Codes are replaced with the corresponding field data or 

text upon insertion. The code replacement list is managed by the administrator. 

1. Select the record from the Results, click the Open menu and choose Edit Document. If you do not 

see the Edit Document option, you do not have permission to edit content records. 

 

2. Delete the text to replace with a code or place your cursor where you'd like to insert the code. 
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3. Make sure your cursor is where the code goes and then click the Insert Word Replacements icon. 

 

4. Select the appropriate code, and then click Insert. 
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5. Review the text to ensure the spacing and formatting are as desired, and then click Save. 

 

6. Close the record. 

 

Edit Record  
1. Navigate to Content > Home. 
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2. Select the record to edit. If you do not see the Edit Document option, you do not have permission 

to edit content records. 

3. Click the Open menu and choose Edit Document. 

 

TIPS 

 If a record is checked out for compliance, do not make edits until after it's checked in because 

it will be overwritten when compliance is approved. 

4. Make edits to the content and/or the short answer, click Save, and then close the window. 
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5. With the record still selected, click on the Attributes tab. 

 

6. Make appropriate attribute changes, and then click Save.  

 

Delete Document  
1. Select the record to delete, and then click Delete Document. If you don't see this button, you don't 

have permission to delete records. 

 

2. Only one prompt will pop up to confirm the deletion and the delete cannot be undone. Click OK to 

proceed. 
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TIPS 

 Delete cannot be undone and a deleted document cannot be recovered. Exercise caution when 
deleting records. Use the Download Document option to download a copy before permanently 

deleting. Alternatively, mark a record as archived and then add a restriction to hide these 

records from users. 

Add Record  

Add Record from Search  

1. Click Add Record. If you don't see this button, you don't have permission to add content records. 

 

2. Select the document type you would like to add, and then click Next. 

 

TIPS 

 When adding Word documents that are question-and-answer pairs, be sure there is one blank 

empty line (hard return) between the question and answer. 

 When adding Word documents, the option is provided to use a style template. Use the 

template as instructed by the administrator to ensure consistency with brand guidelines as 

appropriate. If no template is selected, the document will be based off the local user's 

Normal.dotm Word instance. 

 When adding Word documents that are question-and-answer pairs, be sure to check the Q & A 

checkbox on the Attributes tab. 

 When adding documents that are not question-and-answer pairs, use the Browse option to 

quickly create the new record from an existing document. 
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3. If presented, choose a template, and then click Next. 

 

4. Input the content for the new record. Enter two hard returns after the question(s) and then input 

the response. 
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5. Go to the Attributes tab. 

 

6. Select an Attribute Group to quickly prefill multiple fields, or manually make selections, and then 

click Save. 
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7. To save the record without requesting compliance, click Save at the prompt. To request 

compliance, refer to the Compliance user guide. 

 

Add Q&A (Smart Add)  

When working on an RFP document from the dashboard, users quickly add a new search record using 

the Add Q&A option. 

1. From the main menu, click Proposals. 
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2. Click the file type button for the proposal record. 

 

Or, select the proposal (row will have a light blue background), and click Edit Proposal. 
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3. In the Proposal Editor window, select (highlight with the cursor) the content to add, and then click 

the Add Q&A button. 
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4. If the record is a question-and-answer pair, ensure there is a blank hard return (empty line) 

between the question and answer, and remove the blank line at the end of the answer. 

 

5. Select an Attribute Group from the picklist. If no attribute group is selected, the record will be 

added without any attributes. The record can't be added without selecting an attribute group. 
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Download/Checkout and Upload Docs  

Download/Checkout  

Another option for updating content records is to check them out using the Download option and 

check them in using the Upload option. This option downloads a copy of each record as a separate 

document. This option is ideal if you want to entirely replace a document with another one (e.g., a 

PDF file that has a new version or a content record that has new branding). The downloaded 

document's file name is the Search ID number followed by the text in the Summary field (if any). To 

check in these documents, simply ensure you name the file the same file name as the original 

download. 

1. Navigate to Content > Home. 

 

2. Filter and/or search for the records to download, and then click the Download/Checkout button. 

 

3. At the prompt, click OK to proceed. 
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4. Check the option Checkout Files For Editing, choose a folder to download the documents to, and 

then, click Download. 

 

Upload Docs  

1. Click the Upload Docs button. 
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3. Click Select Files…. 

 

4. Select the records to check in (use the CTRL or SHIFT to choose multiple files at once), and then 

click Open. 
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5. Wait for the files to load in the window, and then click the Upload button. The window will simply 

close when the process is complete. 

 

TIPS 

 When using this feature to update branding, open the checked-out document, select all 

contents and copy into the new branding document. Then, apply any formatting changes. 
Close the original checked-out document and save the new file as the same name as the new 

version. 

 Before checking in updated records, filter for those records so that it's simple to update the 

expiration date for all records at once, if needed. 

Create an Attribute Group  

Users with permission can add new attribute groups. An attribute group is a template of attribute 

values. To add an attribute group: 

1. Locate the record that has t set of attributes to save, and then click on the Attributes tab. 
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2. Review the attributes to confirm the values that will be in the template, and then click Save as 

Attribute Group. 
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3. Enter the name for the attribute group, and then click Ok. 

 

4. At the confirmation prompt, click OK. 

  

Global Attribute Changes 

The Global Attribute Changes features allows users to apply mass changes to one or more content 

records at once. To make global changes to Search records, follow the steps below. 

1. From the main menu, navigate to Content > Home. 
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2. Narrow the results to records that need global changes and the click Global Attribute Changes 

button. 

 

3. Make desired changes to the field values and when ready, click Apply. 

 

TIPS 

 Use the new [CLEAR VALUES] option to clear any then-existing values from a field within the 

selected records (available only for applicable field types. 
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 Scroll up and down to reveal fields in other 

tabs. 

 

 

 

 

 

4. Validate the number of files that will change, and then click OK. Click Cancel if you would like to 

revise the filters or changes. 

 

5. Wait for the processing window to process all records before attempting to navigate away or close 

the window. 

 

TIPS 

 It may be necessary to remove or modify filters/sorting to reveal the changes. 

 

Building Parent Child Records  

The parent/child relationship feature facilitates managing content where there is a parent record in 

one language and child record(s) in one or more different languages. 

We recommend following the best practices workflow below when managing parent/child record 

relationships. 
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1. Use Compliance to send all or single parent records to content experts. Compliance allows you to 
combine multiple records into a single document, which makes it easier for the content expert to 

update. 

2. Review and validate updated documents provided by content experts, and then use Compliance to 

import updated records. 

3. Approve all records in Compliance. This will trigger the “Needs Translation” process for all 

associated child records of approved parent records where the record content changed. 

4. Use the Needs Translation field to filter the records that need translation and then use the 
Download All feature to download the child records. Each record will be downloaded as an 

individual Word document. Send the documents to your translation services for updating. 

6. Use the Upload Records feature to import the translated child records. This action removes all 

"Needs Translation" triggers for the imported records. 

There are three permissions required to use all parent/child record features: Multiple Doc Download, 

Multiple Doc Upload, and Run Verify Process. 

 

Add Languages 

1. If you are not on the Content page, go to the main menu and click Content. 
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2. Click on the Attributes tab. 

 

3. Click the Edit button next to the Language field. 
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4. Click the Edit Values button. 

 

5. Click the + icon to add a new value to the list. 
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6. Add the language in the space provided and click Save. 

 

7. Repeat steps 5 and 6 until all languages are in the list and click Save. 
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Upload Templates  

1. Go to the main menu, choose Content, and then choose Settings. 

 

2. Click on Document Templates. 
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3. Under Microsoft Word Templates click Add New Word Template. 

 

4. Enter a name for the template. 

 

5. Choose the language for the template. 
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6. Click Choose File…. 

 

7. Select the template to upload and click Open. 

 

8. Click Save. 
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Add Parent Record  

1. Click Add Record. If you don't see this button, you don't have permission to add content records. 

 

2. Select the document type you would like to add, and then click Next. 

 

TIPS 

 When adding Word documents that are question-and-answer pairs, be sure there is one blank 

empty line (hard return) between the question and answer. 

 When adding Word documents, the option is provided to use a style template. Use the 

template as instructed by the administrator to ensure consistency with brand guidelines as 

appropriate. If no template is selected, the document will be based off the local user's 

Normal.dotm Word instance. 

 When adding Word documents that are question-and-answer pairs, be sure to check the Q & A 

checkbox on the Attributes tab. 

 When adding documents that are not question-and-answer pairs, use the Browse option to 

quickly create the new record from an existing document. 
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3. If presented, choose a template, and then click Next. 

 

4. Input the content for the new record. Enter two hard returns after the question(s) and then input 

the response. 
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5. Go to the Attributes tab. 

 

6. Select an Attribute Group to quickly prefill multiple fields, or manually make selections, and then 

click Save. 
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7. Check the box next to Create Child Relationships and uncheck any languages to exclude. 

 

8. Choose an option for Compliance. 

a. Click Save to Compliance Central to place the record in the Not Sent tab, and then click Save. 
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b. Click Save to Compliance Central and Request Compliance Immediately (SME will be notified) 

to immediately email the record to the designated SME. Enter a Due Date and then click Save. 

 

9. Click Clear Search to refresh the page. 

 

10. The newly added parent and child records will be at the top unless there is other sorting in place. 
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Send Parent Record  

If the option to save to compliance central was not used, follow the steps below to send the parent 

record to the designated SME. If the option to send immediately was used, skip to the next section. 

1. If you are not on the Content page, go to the main menu and click Content. 

 

2. Click Modify Filters. 

 

3. From the Add new filter picklist, choose Is Parent. 
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4. Check the box next to True, and then click Apply. 

 

5. Click the Send All Records to Compliance button. 
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6. Select Add to Compliance Central, choose Order By to group records together, adjust what to 

include with the content, and then click Submit. 

 

Approve Parent Record  

To upload revised parent record record(s), use the Import feature. 

1. From the main menu, click on Content, then Compliance. 

 

2. Click the Import button. 
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3. Click the Select Files… button. 

 

5. Navigate to file location, select the updated document(s), and then click Open. You can select 

more than one document at once. You can also continue to click Select Files… to select additional 

documents. 
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6. To import the updated documents, click the Upload button. 

 

7. ResponseFull will be closing and opening Word during this process, so wait for the processing 

window to complete and close before doing any other work. 

 

8. Click Refresh button to refresh the Compliance page (this will also close the window). 
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9. Click on the Returned From SME tab. 

 

10. Check the box next to the records to approve (or check the box in the header row to select all), 

and then click the Approve button. 

 

11. Confirm the number of records to approve, and then click OK. 

 

12. Click the Refresh button to refresh Compliance. 

Send Child Record  

If you have followed the steps above to review and approve parent record(s), all associated child 

records are triggered for the "Needs Translation" process. 

1. Create a local folder for the child records. 

2. If you are not on the Content page, go to the main menu and click Content. 
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2. Click Modify Filters. 

 

3. From the Add new filter picklist, choose Is Child. 
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4. Check the box next to True. 

 

5. From the Add new filter picklist, choose Needs Translation. 
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6. Check the box next to True, and then click Apply. 

 

7. Click the Download All icon. 

 

8. Click OK to proceed. 
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9. Click the Browse… icon. 

 

10. Choose the local folder and click OK. 
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11. Save the files: 

1) Check the Download parent record with current ID to send the parent version of the record for 

each associated child record. 

2) Check the Flag child record box to capture the Date Downloaded and Downloaded By attribute 

details. 

3) Click Download. 

 

Upload Child Record(s)  

To update the translated child records: 

1. If you are not on the Content page, go to the main menu and click Content. 
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2. Click the Upload Docs button. 

 

3. Click Select Files…. 
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4. Select the child records to import (use the CTRL or SHIFT to choose multiple files at once), and 

then click Open. 

 

Once the window closes, the process is complete.  

Update Records Using Compliance  
Compliance stores all content records that have not been sent, have been sent, and have been 

returned (but not yet approved). 

Automated Review Frequency  

Compliance is programmed to automatically apply a new expiration date based on the using an exact 

value as the review frequency. The automated extension applied is set from the date the records are 

approved in Compliance. 

Review Frequency 

Value 

Automated Extension Applied 

Annually 1 year from date approved 

Yearly 1 year from date approved 

Semi-Annually 6 months from date approved 

Quarterly 3 months from date approved 

Monthly 1 Month from date approved 

1st Quarter The next January 1 after date approved 
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2nd Quarter The next April 1 after date approved 

3rd Quarter The next July 1 after date approved 

4th Quarter The next October 1 after date approved 

X Days X number of days after date approved (valid integer only) – for example, if the review 

frequency value is “45 Days” the expiration date is updated to 45 days after the date 

approved 

X Weeks X number of weeks after date approved (valid integer only) – for example, if the 

review frequency value is “6 Weeks” the expiration date is updated to 6 weeks after 

the date approved 

X Months X number of months after date approved (valid integer only) – for example, if the 

review frequency value is “18 Months” the expiration date is updated to 18 months 

after the date approved 

Request Compliance  

Send Single Record  

1. If you are not on the Content page, go to the main menu and click Content. 

 

2. Select the record and click the Send Record to Compliance button. 
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3. Make changes to the content (if necessary), and then go the Attributes tab. 

 

4. Make changes to the attributes (if necessary) and click the Save button. An SME must be selected 

to proceed. 

 



 

 

User Guide: Content 84 Rev:  4/23/2019 

5. Choose one of two options: a) save to pending area (default); or b) send immediately. 

a) Click Save to Compliance Central to place the record in the Not Sent tab, and then click Save. 

 

b) Click Save to Compliance Central and Request Compliance Immediately (SME will be notified) 

to immediately email the record to the designated SME, and then click Save. 
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Send All Records 

1. If you are not on the Content page, go to the main menu and click Content. 

 

2. To send one or more records through Compliance, apply filters to display all the records you'd like 

to update, and then click the Send All Records to Compliance button. A single record can be 

processed this way. 
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5. Choose one of the two options: a) save to pending area (default); or b) send immediately. Do not 

use Internal Review Only if you plan to import updated records back into Compliance. 

a) Select Add to Compliance Central and then click Submit. 

 

b) Select Add to Compliance Central, choose Order By to group records together, adjust what to 

include with the content, and then click Submit. 
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Internal Review Only  

Internal Review Only allows records to exported for informational purposes only. The exported 

document(s) cannot be used to automatically update records through Compliance. 

TIPS 

 If you'd like to sort by more than one attribute, choose the option to Add to Compliance 
Central. These items will quickly be placed into the pending (Not Sent tab) area in Compliance 

where they can be downloaded using two sort options. 

Manage Compliance Items  

Send to SME  

1. From the main menu, click on Content, then Compliance. 
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2. From the Not Sent tab, click the checkbox next to each record to send (or click the checkbox in 

the header row to select all), and then click the Send to SME button. 

 

3. Check the Include Attributes box, enter a Due Date, and then click OK. 

 

Additional Options 

1. To include notes already applied to a record, check the Include Notes box. 

2. To add a note to the selected records, click the Include Notes box, then click Add notes to the 

items and enter the desired notes. 

3. To change the SME, check the Change the SME or Compliance Approval box. This will change the 

SME permanently. 

4. To carbon copy someone, check the Add CCs to email and enter the email addresses separated by 

a semi-colon. 

5. To open a calendar reminder, check the Download an ICAL Reminder box. 
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6. To send a calendar to the recipient, check the Attach an ICAL Reminder box. 

 

7. Click the Refresh button to refresh Compliance and close the window. 
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Download  

Use the Download option to create a Word document you can attach to a custom email. 

1. From the main menu, click on Content, then Compliance. 

 

2. Click the checkbox next to each record to send, and then click the Download button. 
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2. Check the option Mark downloaded items as sent. This is required to import the updated record 

back into Compliance. 

 

3. Check the Include Attributes box, enter a Due Date, update the Sort By, and then click OK. 

 



 

 

User Guide: Content 92 Rev:  4/23/2019 

Additional Options 

1. To open a calendar reminder, check the Download an ICAL Reminder box. 

2. To sort the records by an attribute, choose an option under Sort By. 

3. To sort the records by an additional attribute, choose an option under Then By. 

4. To add a note to all records, click the Include Notes box, then click Add notes to the items and 

enter the desired notes. 
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Import  

To upload update content record documents, use the Import feature. Make sure the document(s) 

is(are) closed and in a location where they are easy to find. 

1. From the main menu, click on Content, then Compliance. 

 

2. Click the Import button. 

 

3. Click the Select Files… button. 
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5. Navigate to file location, select the updated document(s), and then click Open. You can select 
more than one document at once. You can also continue to click Select Files… to select additional 

documents. 

 

6. To import the updated documents, click the Upload button. 

 



 

 

User Guide: Content 95 Rev:  4/23/2019 

7. ResponseFull will be closing and opening Word during this process, so wait for the processing 

window to complete and close before doing any other work. 

 

8. Click Refresh button to refresh the Compliance page (this will also close the window). 

 

Review 

1. To view an individual content record before approval, click the View Document button next to the 

record. 
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2. To manually edit an individual content record before approval, check the box next to the record 

and click the Edit button. Save changes and close the record before approving. 

 

TIPS 

 Check the review frequency of content records before approving the updates back to the 

content records. This helps you ensure you are updating the expiration date appropriately (or 

not updating at all depending on preference) on approval. 

 Review the updated documents before importing them into Compliance. It's faster to review 

these in a single document where all that's required is to Approve the records in just three 

clicks. 

Approve  

Whenever there are records that have been imported into Compliance, the final step in the process is 

to approve them. 

1. From the main menu, click on Content, then Compliance. 
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2. Click on the Returned From SME tab. 

 

3. Check the box next to the records to approve (or check the box in the header row to select all), 

and then click the Approve button. 

 

4. Confirm the number of records to approve, and then click OK. 

 

Delete  

You can remove content record(s) from Compliance. This will not delete a record from ResponseFull. It 

is not advisable to remove content records from the Returned From SME tab because you will lose any 

updates to that(those) content record(s). 

Not Sent Records  

1. Check the box(es) next to the record(s) to remove, and then click the Delete button. 
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2. Click Yes to proceed or No to cancel. The page will automatically refresh. 

 

Sent Records  

1. Check the box(es) next to the record(s) to remove, and then click the Delete button. 

 

2. Choose whether to notify the SME, and then click Yes to proceed or No to cancel. The page will 

automatically refresh. 
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Reports  
Access to Reports is available from both the Proposals and Content modules. All users may can view 

and edit reports they create. Administrators have access to all reports and may also designate other 

users with admin access to all reports. 

  

Select  

Users can view and edit all reports to which they have access on the Select tab. By default, the user 

will see only reports they have created. To see all reports, check the box next to View all reports. 

1. The Scope column indicates whether a report is Private  or Public . 

2. The Type column indicates whether a report is a Content  or Proposal  report. 

3. The Created report indicates the date and time the report was created. 

4. The Creator column indicates the user name of the person who created the report. 

5. The Last Edited column indicates the date and time the report was last edited. 

6. The Edited By column indicates the user name of the person last edited the report. 

7. The Name column is the name given to the report. 
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New Report 

To create a new report, click the New Report button. 

 

Refer to the numbered items related to the screen shot below for report options. 

 

1. Select the type of report from the dropdown, either for Proposals (proposal record attributes) or 

Q+A Documents (content record attributes). 

2. Type a name for the report. 

3. To make this report available to all users, check Save as Public Report (everyone can see). 

4. To set a default ascending sort order, choose from the Sort results by dropdown. Check Invert 

Sort to sort in descending order. This attribute does not have to be a visible field in the report. 

5. Select the Visible fields to include in the report by checking the box next to each. Arrange the 

order by using the up/down and top/bottom arrows. 

6. Click OK to save the report. 
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To view the report, select it from the list and click the View tab (or double-click on the report). 

 

Edit Properties  

1. Select the report to edit (single click) and click the Edit Properties button. 

 

2. Make changes and click OK to save. 

3. To view the report, select it from the list and click the View tab (or double-click on the report). 
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Build Tab 

Go to the Build tab to apply conditions for the report. 

 

1. Click Save Changes after making any changes to conditions before viewing the report. 

2. Click Add Term to add a condition. 

3. Click Add Group to add a group. 

4. Click Clear All to remove all conditions and groups. 

Add a Condition  

To apply a condition, select the report and then on the Build tab. 
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1. To add a condition, click the Add Term button  and refer to the numbered items related to the 

screen shot below. 

 

2. In the Select Attribute dropdown, select attribute to filter. 

3. In the Select an Operator dropdown, select an operator appropriate to the selected attribute. 

4. In the value field, choose the desired value. Note the results indicated by the query. 

5. Click OK. 

 

Repeat steps 1 through 5 to add multiple conditions. Learn about groups in the next section. 

file:///C:/Users/Colleen%20Charland/AppData/Local/Temp/WebPro/TempDownloads/724e9ca6-de40-4961-8ca8-22a8a8d455bf_0.docx%23AddGroup
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6. Click Save Changes and click the View tab to view the modified report. 

 

Add a Group  

Go to the Build tab to apply conditions for the report. 

 

1. To add a grouping, click the Add Group button. 

 

2. Drag-and-drop the condition into the group window. The grey grouping box will turn blue when 

the condition is in the window. 
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3. Drag-and-drop until all conditions are in the group window. 

 

4. Choose the type of group. 

a. Choose OR to include results where any of the conditions are met. 

b. Choose AND to include results where all conditions are met. 

5. Click Save Changes and click the View tab to view the modified report. 

 

View Tab 

1. To view a report, select it from the list and click the View tab (or double-click on the report). 
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2. To view the full report in a separate web page, click the View Full Report button. 

 

3. To export the report data, click the Export button. 

 

4. Click on the export type to export the report data. 

 

Content Settings 

Attribute Groups  

Attribute Groups are templates that auto-fill a set of attribute values for content records and are not 

linked to the records. Attribute groups are managed in Content > Settings, which requires 

Administrator permission. 
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Add an Attribute Group 

1. From the main menu, choose Content then Settings. 

 

2. Choose Attribute Groups and click Add New Attribute Group. 
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3. Select the values that should be auto-fill when using the attribute group. 

 

TIPS 

 Always choose a SME, even if it's only a placeholder. This will ensure you can use all the 

Content and Compliance tools to manage your content. 

 Use thoughtful consideration when entering expiration dates, knowing that it will be necessary 

to update these when those expiration dates pass. 

 If the record is a question-and-answer pair, check the Q & A checkbox so that the insert 

feature will work properly and only insert the response. 

 Use a Group Name that will be easy to understand. 
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4. Enter a meaningful Group Name for the set of values, and then click Save. 

 

Edit an Attribute Group 

1. From the main menu, choose Content then Settings. 

 

2. Choose Attribute Groups. 
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3. Click the Edit button next to the Attribute Group to change. 

 

4. Make appropriate changes and click Save. Note: this will not update any existing records. There is 

no link between attribute groups and records. 

 

Delete an Attribute Group 

1. From the main menu, choose Content then Settings. 
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2. Choose Attribute Groups. 

 

3. Click the Delete button next to the Attribute Group to remove. 

 

4. Click OK to proceed. 

  

Indexed Directories 

Server Files 

Indexed Directories are folder shares on your server that contain documents you'd like to store and 

search using ResponseFull. It enables one-way synchronization of documents from a folder share into 

a ResponseFull web application and continuously scans for permitted file types (.doc .docx .xls .xlsx 

.ppt .pptx .pdf). Indexed documents are read only and exempt from editing, deleting, and using 

compliance, meaning these activities must take place in the folder share. This requires that the 

Indexer application be installed, configured, and running on a local server. If you are interested in 

using this functionality, please contact your customer success manager or submit a ticket. 

Add a Directory 

1. From the main menu, choose Content then Settings. 

https://tw.rocketdocs.com/support/#/tickets/new
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2. Click on Indexed Directories. 

 

3. Click Add New Directory. 

 

4. click the radio button UNC/Web. 
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5. Enter the UNC Directory for the location of the files. Do not use mapped network drives unless 
you'll be installing and running the indexer from that same computer. Leave the Enabled box 

checked. Note: once you have saved a new directory, the UNC Directory cannot be 

altered, and you'll have to delete and start over to make corrections. 

 

6. To include sub-folders under the UNC Directory, check the Scan Sub Directories box. 

 

7. Leave the option set to Store Files on Web Server (Highly Recommended). Note: if you elect to 

Keep file in existing location, any user that tries to view or download these files must 

also have access to that folder and it may take much longer to view/download these 

files. 
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8. Uncheck file type extensions to exclude those from indexing. 

 

10. Select an Indexer. This is mandatory before you can save the new directory. 
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11. Select the attributes that will be applied to all files indexed from this directory, and then click 

Save. 

  

The final step is to go to the Configuration settings and edit the directory so that user(s) and/or 

group(s) have access. These instructions are in the Configuration userguide. 

Synonyms  

Use Synonyms to help users locate records when searching for content responses, especially for 

unique words to your organization or industry. Attribute groups are managed in Content > Settings, 

which requires Administrator permission. 

Add a Synonym  

1. From the main menu, choose Content then Settings. 
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2. Click on Synonyms. 

 

3. Click New Synonym. 

 

4. Enter the word. 

 

5. Enter a synonym for the word, and then click Save. 

 

TIPS 

 There is no need to enter the word as both a word and synonym because the entries are 

reciprocal, meaning if a user has the option to search synonyms enabled, and searches for 

either the word or the synonym, it will find the synonym or the word in the results. 

Edit a Synonym  

1. From the main menu, choose Content then Settings. 
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2. Click on Synonyms. 

 

3. Click the Edit next to the synonym. 

 

2. Make the changes and click Save. 

 

Delete a Synonym 

1. From the main menu, choose Content then Settings. 
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2. Click on Synonyms. 

 

3. Click the Delete next to the synonym. 

 

Request Compliance Email 

Use this page to customize the outgoing email used for compliance requests. 

From the main menu, choose Content then Settings. 
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Click on Request Compliance Email to customize the email. This applies to all requests sent 

automatically by the system. 

 

1. Edit the Subject text. 

2. Edit the Body text. 

3. Use the codes where the system will automatically replace important information in the email. 

4. The email displays using HTML formatting, so at any time during the update process, click the 

Preview icon to review the look of the changes, and then click Save to complete. 

 

HTML Code Action 

<br/> Adds a line break after the text. 

<b> Begins bold text. 

</b> Ends bold text. 

<i> Begins italicized text. 
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</i> Ends italicized text. 

 

Verification Scheduler  

The Verification Scheduler enables automatic disbursement of content records to the assigned SME. 

This process is based on an automated schedule associated with a Saved Search and only records 

where the Doc Type=Search and File Type=Word may be sent. This option requires custom 

configuration to process the requests. To request more information about this functionality, please 

contact your customer success manager or submit a ticket. 

Create a Saved Search 

1. From the main menu, click Content. 

 

2. Click the Modify Columns icon. 

 

https://tw.rocketdocs.com/support/#/tickets/new
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3. Under Add new filter, select Doc Type. 

 

4. Check the box next to Search. 

 

5. Under Add new filter, select the File Type field. 
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6. Check the box next to Word. 

 

7. Apply any other filters and search options, and then click Apply. 

 

8. Click the Save Search link. 
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2. Enter a name for the saved search, and then click Ok. 

 

Create a Schedule 

1. From the main menu, choose Content then Settings. 

 

2. Click on Verification Scheduler. 

 

3. Click Schedule New Verification. 
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4. Enter a Process Name. 

 

5. Select the saved search from the Search Criteria dropdown. Items display by the user's name, last 

name first, and then the name of the saved search. 

 



 

 

User Guide: Content 125 Rev:  4/23/2019 

6. Select the desired frequency from the Schedule options, and then click Save. 

a. When using Single Date, specify the next scheduled date the process should run. The Next 

Scheduled Date will populate automatically based on the calendar. 

 

b. When using Single Date, specify the next scheduled date the process should run. The Next 

Scheduled Date will populate automatically based on the calendar. 
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c. When using Single Date, specify the next scheduled date the process should run. 

 

d. When using Days of Month, select the appropriate days or week. The Next Scheduled Date will 

populate automatically based on the calendar. 
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Word Replacements 

Word Replacements are text word codes that are automatically found and replaced when using specific 

ResponseFull functions: 

 Insert Full or Insert Selected Text 

 Codes in records that are inserted using this feature are automatically replaced 

 Microsoft Word only (in Excel and PowerPoint the Run Word Replacements must be run) 

 Run Word Replacement can be run at any time in Word, Excel and PowerPoint 

 Relink Document 

 Codes in records that are re-inserted using this feature are automatically replaced 

 Run Word Replacement can be run at any time in Word, Excel and PowerPoint 

 Assembly Center 

 Codes in any documents combined using assembly center are automatically replaced 

 Sales Docs/WinFull 

 Codes in any documents created using sales docs forms are automatically replaced 

Add a Code 

1. From the main menu, choose Content then Settings. 

 

2. Click on Word Replacements. 
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3. Click Add New. 

 

4. Enter the Replacement Keyword surrounded by non-alphanumeric characters (e.g., { }, [  ], < >). 

This allows the word replacement code to be easily distinguishable from other text. The 

Replacement Keyword is not case sensitive, meaning that you can enter the code in any case and 

it will always be replaced. 

 

5. Select the replacement type option Use Exact Text. 

a. Select Use Exact Text to replace the keyword with the value populated in here. 
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b. Enter the Replacement Text for the keyword. 

 

6. Select the replacement type option Use Mapped Field. 

a. Select Use Mapped Field to replace keyword with the value from the related proposal's 

attribute field when the document is edited using the viewer. 

 

b. Choose Proposal from the Q&A or Proposal dropdown. 
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c. Choose the field the value should pull from in the Field dropdown. 

 

7. Click OK. 

 

Edit a Code Value 

1. Click Edit icon on the line of the code you would like to modify. 
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2. Make changes and click OK. 

 

Delete a Code 

1. Click the Delete next to the keyword. 

 

Document Templates 

Store Microsoft Word and PowerPoint templates to use for adding new content records. Templates can 

be associated with a language if using the custom language download feature. 

Microsoft Word 

Add New Word Template 

1. From the main menu, choose Content then Settings. 
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2. Click on Document Templates. 

 

3. Under Microsoft Word Templates click Add New Word Template. 

 

4. Enter a name for the template. 

 

5. Choose a language for the template, if appropriate. Leave this empty if you are not using the 

custom language download feature. 
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6. Click Choose File…. 

 

7. Select the template to upload and click Open. 

 

8. Click Save. 
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Edit a Template 

1. From the main menu, choose Content then Settings. 

 

2. Click on Document Templates. 

 

3. Under Microsoft Word Templates click the edit icon for the template to modify. 
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4. To replace the document, follow the steps below. 

a. Click Choose File…. 

 

b. Select the template to upload and click Open. 

 

c. Click Save. 

 



 

 

User Guide: Content 136 Rev:  4/23/2019 

5. To modify the template properties, follow the steps below: 

a. Make desired changes, and then click Save. 

 

Delete a Template 

1. From the main menu, choose Content then Settings. 

 

2. Click on Document Templates. 

 

3. Click the edit icon next to the template to remove. 
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4. Click the Delete button. 

 

5. Click OK to proceed. 

 

Microsoft PowerPoint 

Add a Template 

1. From the main menu, choose Content then Settings. 

 

2. Click on Document Templates. 
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3. Under To add a new PowerPoint section, click Choose File. 

 

4. Select the template file and click Open. 

 

3. Enter a description for the template, and then click Upload PowerPoint…. 
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Delete a Template 

1. From the main menu, choose Content then Settings. 

 

2. Click on Document Templates. 

 

3. Click the delete button next to the template to remove. 

 

4. Click OK to proceed. 

 

 

 



 

 

 


